ECE 241L * Intro to EE Lab

Lab 4 : Introduction to LTSpice
Objective: To become familiar with the basics of LTSpice for circuit simulation. 
Equipment:
Computer with LTSpice installed, ECE 241 textbook
Introduction: 

Spice (Simulation Program with Integrated Circuit Emphasis) is a widely-used computer simulation program.  PSpice is the version developed for PC’s.  Many different versions of PSpice are available, all having the same basic simulation code but with different user interfaces, device libraries, plotting programs and various additions.  In an effort towards uniformity, we try to use LTSpice for all our ECE classes and labs.  This lab will provide an overview of the basic operations.  You will continue to learn more about the capabilities of LTSpice throughout future courses.

LTSpice is also called SwitcherCad III.  It is a free program available from Linear Technology at http://www.linear.com/company/software.jsp.  You can easily download it to your own computer.  There is not a lot of documentation available from LT itself, but there is other support online.  There is a Yahoo group for LTSpice at http://groups.yahoo.com/group/LTspice/.  They have many files for download, including several tutorials and an extensive (290+ page) manual.  This lab is largely based on a tutorial written by Nick Kennedy, an amateur radio enthusiast.  His web page is http://www.cox-internet.com/wa5bdu/ltguide.doc. 
Before the lab:

     1. It is suggested that you download LTSpice to your own computer.  You will use this program in a lot of ECE classes and it will be more convenient to have it available outside of the lab.

     2. Look over the tutorial section of the lab.  The details will not mean a lot until you are actually doing the lab, but just get an idea of what instructions are available here, and refer back to it as needed.
     3. Bring your textbook to the lab (if you have a hard copy.)  Some of the circuits you will simulate are problems out of the book.

Introduction to LTSpice tutorial

     The following sections provide instructions for drawing and simulating circuits in LTSpice. Refer to these instructions to complete the exercises in the lab procedure.  
     In general, most actions can be accomplished through a drop-down menu, a toolbar button or a keyboard shortcut.  These instructions give you all three options, which may make it sound more complicated than it is.  I suggest you just use whichever option you prefer and not worry about trying to do everything three different ways!
Drawing the circuit

     Double-click on the SwCAD III icon to open the program.  Go to File – New Schematic or the toolbar button to start a new drawing.  To place common circuit components on the schematic, you can use the keyboard, the Toolbar or the Edit menu:  

· for a resistor:  type ‘R’ or push the toolbar button with the resistor symbol

· for a capacitor: type ‘C’ or push the toolbar button with the capacitor symbol

· for an inductor:  type ‘L’ or push the toolbar button with the inductor symbol

· for a ground:  type ‘G’ or push the toolbar button with the ground (triangle) symbol.  You must have a ground in your circuit!
· for a diode: type ‘D’ or push the toolbar button with the diode symbol.

For other components, press F2 or the component button (the AND gate symbol) and a menu comes up.  Find your component and double-click.  On the left are other sub-menus of parts you may need.  
     In each case, the component appears when you move the mouse.  Move it to the desired location and click.  Press ctrl-r to rotate before placing.  After placing, you are ready to place another of the same type.  Right-click, press a different key or button or press ESC to exit placing that component type.

     You can connect components by aligning their terminals when you place them on the drawing, otherwise use the wire function.  Press F3 or the wire button (the pencil and blue line).  Click at the first point, click at any intermediate points where you need to make 90o turns, then click at the second terminal point.  Crossed lines are not connected.  If you want a junction of wires and not a crossing, you need to click at the junction (look for the blue square that indicates a junction.)

     To assign values to components, move the cursor over the component until the pointing finger appears.  Right-click and type in the value.  
     For this class you should use the regular sources called “voltage” and “current.”  There are also behavioral sources (“bv” and “bi”) where you enter an equation to describe the operation of the source.  These are used for more specialized types of simulations.  

     The same voltage and current sources are used for AC, DC or other types.  For DC sources, just put in the DC value.  For time-varying sources, click Advanced, go to the left side and click on the appropriate type such as Sine or Pulse.  Enter the required parameters such as amplitude (zero-to-peak value) and frequency for sine waves.  Some options, such as DC offset or Tdelay, can just be left blank if not needed.  For AC (frequency response) analysis, go to the Small Signal AC section and type “AC” (which assigns the default peak value of 1 V or 1 A to the source) or a different value in the amplitude block. 

     In assigning units, you can use p for pico, n for nano, u for micro, k for kilo, m for milli and MEG for mega.  (Be careful: a common mistake is using M for mega, but it will give you milli!)  You can use either conventional American 4.7k for a 4.7 k resistor or the international 4k7.  You do not have to put V for volts, Hz for hertz and so on, but there is no problem if you do.

     LTSpice labels components as R1, R2, C1, C2 and so on.  You can change them as you like by right-clicking the label and typing in the new name.  To label nodes, press F4 or the “label net” button (the box with an ‘A’ in it) and type in a name.  Place the dot over the wire or node and click.  There are a couple of reasons to do this:

· you can give logical names like “out” and “in” to nodes so it is easier to pick out the ones you want to plot from a list

· if a certain node connects to many points in the circuit, you can eliminate a lot of messy wiring on the drawing by giving all the nodes the same name.  For example, label your positive power supply terminal “V+” and then put the same V+ name on all points connecting to that bus.  It has the same effect as connecting them with wires.

     If you want to add text comments, press ‘T’.  Type in the text, ending each line with ctrl-m, and place on the drawing.  Under Tools / Control Panel / Drafting Options, you can select the font size.
     Finally, some miscellaneous commands:

· to delete, press the scissors button on the Toolbar or F5.  Move the scissors icon to the desired component, wire or other entity and click.

· to move a placed component: press the move key (the hand with spread fingers) or F7.  Click the component and move it to its new location, it is disconnected from any wiring.  To rotate (ctrl-r) or mirror (ctrl-e) a component that is already placed you need to use Move to select first.
· to copy: press the copy button (two sheets of paper) or F6 (use Move to select first.)

Analyzing the circuit

     To set-up a simulation, go to the Simulate menu and choose Edit Simulation Cmd.  In every case after you set it up and choose OK, a text command is attached to your cursor and you must click somewhere on the drawing to make it effective for the next Run command.

     Use DC operating point for DC circuits and to check biasing and DC levels in electronic circuits.  There are no parameters to set.  Drop the command on the drawing and press the Run button (the running figure.)  A window with DC voltages and currents pops up.  You can see them more easily by closing the box and moving the cursor over wires or nodes and reading voltages at the bottom of the screen, or moving the cursor over devices and reading currents.  Even power is given for resistors and sources.

     Use Transient analysis to see your waveforms as a function of time.  For the simulation, you need to enter the start and stop times.  In the source(s), you need to set the waveform (e.g., Sine), magnitude and frequency.  Left-click the source and do this on the left side of the dialog box.  Click Run, and then double click the value you want plotted from the list.  

     In the drawing window:

· click a wire or node (a voltmeter probe appears) to plot the voltage.

· click a device (current probe appears) to plot the current.

· hold down the alt key and click a device (thermometer appears) to plot power.

     Some additional Transient analysis features can be used in the plot window:

· click and drag a section of waveform to zoom in

· ctrl-click the waveform name at the top of the screen to get calculated values.

· left-click (or alt-click) a waveform name to get a cursor you can drag and display values in a box.  Right-click a waveform name and you get a drop down box that allows attaching the first, second, or both cursors.  You can move the cursors around with the mouse and read individual values and their differences in time, frequency and magnitude.

· right-click a waveform name to do waveform math.  For example, you could square V(out) or you could divide V(in) by I(in) to find the input resistance.

     AC analysis is used to see signal versus frequency (widely used for amplifiers, filters and so on.)  Response is in decibels (dB) relative to 1 V on the source.  {Note: the gain G = Vout/Vin measured in dB (decibels) = 20log(G).}  For the simulation, you need to enter the number of points to plot and the starting and ending frequencies.  You must also have a source with its small signal analysis amplitude set to AC or a value.
     There are many more capabilities of LTSpice that you will learn about as we go along, but this should get you started!
Procedure:

     1. Create a schematic for the circuit given in problem P2.70 in the text (Hambley 6th ed.).  Don’t forget to place a ground at the bottom of the circuit.  Call the top of the 5  resistor node A and the top of the 3  node B.
     2. Run a DC operating point simulation.  Record the node voltages and the device currents (not the mesh currents) in Table I on the next page.  Copy and paste the schematic in your report.
Note: the sign of a current depends on the direction as defined by LTSpice.  This depends which way the resistor is placed in the circuit and it’s not always easy to tell!  You can figure it out by the node voltages since positive current will always flow + to – in a resistor.  

     3. Create a schematic for the circuit given in problem P2.53 in the text (Hambley 6th ed.).  Paste the schematic in your report.  Run a DC operating point simulation and find:  v1 = __________________,                v2 = __________________  and  is = __________________.   
How do your results for the above circuits compare with the homework solutions (if assigned) ?  


Table I. 
	
	Voltage
	Current

	A
	
	-----

	B
	
	-----

	I1
	-----
	

	I3
	-----
	

	I5
	-----
	

	I7
	-----
	

	I1
	-----
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     4. Create a schematic for the circuit below.  The source V1 is an ac (sine) source with 0 dc offset (default), 1 V amplitude and 1 kHz frequency.

Run a Transient simulation for 2 ms.  Plot the voltage V1 and the current in R1  (hold down the mouse button to select more than one signal from the menu.)  Are the signals out of phase?  If so, change the current being plotted to –I(R1).  (see the note in step 2)  Copy (Tools menu) and paste this plot in your report. 

     5. You can explore some of the features of the plot window here.  From the Plot Settings menu you can zoom in and out, add or delete traces, add text, adjust axis limits, add a grid, etc.  In the Tools menu you can change your color preferences, and there are also drafting options in the Control Panel such as line thickness and font size.  Try some of  these options.
     6. An important operation is the FFT, which shows the frequency components of a signal.  First, add another ac source to your circuit (wherever you want) with a different frequency, e.g., 2 kHz.  Select FFT from the View menu and observe the FFT of I(R1).  Paste this plot in your report.  You should see large peaks at 1 kHz and the frequency of your second source, and smaller peaks at the harmonics (multiples of the source frequencies.) 

     7. Finally, run an AC analysis on this same circuit.  First, change the resistor R4 to a 1 mF capacitor (circuits with just resistors do not change as a function of frequency!)  Type AC in the AC amplitude box in V1.  Set the simulation to run from 1 Hz to 10 kHz in a decade sweep with 10 points per decade, and plot the voltage across the capacitor.  Paste the plot in your report.  
     The solid line is the voltage (in dB), the dotted line (phase) you can ignore for now.  The cutoff frequency is defined as the frequency where the signal has decreased to 3 dB below its maximum value.  Find the maximum voltage (in dB) and the cutoff frequency from your graph.  (Use the cursors to get accurate answers.)

V(n003) max __________________

cutoff frequency __________________


8.  Write a conclusion for your report as in previous labs.
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